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Will digitization solve my problem? 



 
National Anthropological Archives  

Arcadia project 

 NAA MS 4800 [104], National Anthropological 
Archives, Smithsonian Institution   

 

“Experts estimate that more than 50 percent of the 
world’s living languages will cease to be spoken by 
the end of this century, and with them, the ability to 
confront worldwide environmental challenges will 
be diminished. The digitization project funded by 
Arcadia aims to conserve this knowledge, which is 
currently recorded on materials that are at high risk 
of degrading. The project team plans to create 
digital surrogates of voice recordings and paper 
documents in the NAA, and make them publicly 
available to support researchers and communities 
struggling to research, document and revitalize 
indigenous languages and cultures. Online access 
will make the material widely available for use 
without damage to the historic originals.” 



John P. Harrington Collection web 
portal   

Convening Great Lakes Culture Keepers: A Regional Institute for Tribal Librarians, Archivists, and Museum Curators ,  
April 26-29, 2015 at the Mille Lacs Indian Museum and Trading Post  

http://anthropology.si.edu/naa/harrington/index.html 



Beyond slap & scan 
 
Before beginning a digitization 
project, consider the following: 
 

–  WHY are we digitizing? (The 
lifecycle of the digital file – 
Where did it come from? 
Where is going?) 

–  WHAT are we digitizing? (Are 
there different types of 
materials with different 
needs?) 

–  HOW are we digitizing? 
(Equipment, software, 
people, time, money, space)  

–  WHO are we digitizing for? 
(Who will use these files? 
What will they do with it?) 

Digitization projects are more than 
just slapping photos on a scanner  
 

–  Project planning and 
management 

–  Selection and 
Prioritization 

–  Technical Specifications 
–  Funding 
–  Preservation and Access 
–  Rights Issues 
–  To name just a few! 



 
Digitization Then and Now 

Then 
•  Microfilm as nationally 

accepted standard for 
decades – cost effective 
way to preserve text 
materials 
–  But what about graphic 

materials like paintings 
and photos? 

•  Copy negatives – 
expensive and two 
generations removed 
from original  
–  Original object ! New 

negative ! Copy print 

Now 
•  Digital imaging and 

digitization allows for 
preservation of original 
object (less handling, 
high resolution file for 
detailed viewing) and 
increases access to 
collections  



Then and Now 

John Peabody Harrington papers: Mandan/
Hidatsa/Crow, 1950-1951 
Image name: Accession #1976-95 [NMNH-
Harrington_mf5_r14_0002] 

NAA MS 2046, Fox text by Alfred 
Kiyana on Buffalo dance, 
undated 



Digitization Now   

•  Smithsonian Digitization Program Office Rapid 
Capture Digitization Process 



 
FADGI: Federal Agencies Digitization 

Guidelines Initiative  



Materials: What are we working with? 



File Management and Organizing your Workflow 

    
    

Above image: MNH 8304, Franz Boas posing for figure in USNM exhibit entitled "Hamats'a coming out of secret room" 1895 or before,  
National Anthropological Archives, Smithsonian Institution   



What are the Issues? 

• filenaming 

• formats/compatibility 

• metadata 

• Storage/use 

File Management and Organizing your Workflow 



•  Project planning 

•  Project tracking 

•  Selection and Prioritization 

•  Image Capture 

•  Post-production and Quality 
Control 

•  Secure storage and migration 

File Management and Organizing your Workflow 

Source: DDI Structural Reform Group. “DDI Version 3.0 Conceptual 
Model." DDI Alliance. 2004. <http://www.icpsr.umich.edu/DDI/
committee-info/Concept-Model-WD.pdf>. 



•  What are the goals of the project? 

•  What does a basic workflow look like? 

Project Planning: File Management and Organizing your Workflow 



Sketch out a Workflow Diagram 

Project Planning: File Management and Organizing your Workflow 

•  What are the specific materials you are going to digitize? 

•  Do you have enough storage space for the files? 

•  Begin to develop a filenaming schema – relate to 
collections naming as much as possible 

•  What metadata will you include? 

•  Lifecycle of the image 

•  Storage and migration 



Project Tracking: File Management and Organizing your Workflow 



Folders, Folders, Folders: How you name them matters! 

Project Tracking: File Management and Organizing your Workflow 



Filenaming, Filenaming, Filenaming, Filenaming, Filenaming! 

Pre-Digitization Work: File Management and Organizing your Workflow 

•  Unique identifier; well defined 

•  Persistent and consistent 

•  Versioning 



Pre-Digitization Work: File Management and Organizing your Workflow 



Pre-Digitization Work: File Management and Organizing your Workflow 



Filenaming, Filenaming, Filenaming, Filenaming, Filenaming, 
Filenaming,... 

Pre-Digitization Work: File Management and Organizing your Workflow 

•  Prefix and suffix additions 

•      Examples of filename variations: 
o “v” = verso, the backside of a page 
o “x01” = numbering assigned during 
digitization 

•  “ntbk” – manuscript is a bound 
notebook  

o  “front_cover,” “back_cover” 
“title_page”  

MS 4490   

Main file to distribute/ combines all other files 4490.tif 
  

These files illustrate Left, right, mid section and 
additional “detail views” that may have 
been shot 
  

4490_1_detail.tif 
4490_2_detail.tif 
4490_3_detail.tif 
4490_4_detail.tif 
4490_5_detail.tif 
4490_6_detail.tif 
msnumber_left_1.tif; msnumber_right_1.tif 
  



File Format 

Actual Digitization: File Management and Organizing your Workflow 

.tiff .jpg  .mov  .wav .mp3  .pdf 

Are you saving in a file format that is 
compatible in the long term?  

Hi- bit or low bit depth; Color space 



Secure Storage and Migration 

Actual Digitization: File Management and Organizing your Workflow 

•  Can you access your files easily? 

•  Do you understand your filenaming months 
later after you've been away from the 
project? 

•  Do you have multiple copies in separate 
locations? 

•  What is your storage media? 

•  Do you have a long- term plan for the 
security of you data? 

•  If so you are on your way! 



Additional Resources 

File Management and Organizing your Workflow 

•  Federal Agencies Digitization Guidelines 
Initiative  

•  University of Cambridge Library – Data 
Management, Choosing File Formats 

•  MIT Libraries: Data Management and 
Publishing 



Digitization Project Management 
Selection and Prioritization, A Case Study: 
Breath of Life Archival Institute: 2013, 2015 

Jeanine Nault 
Digital Imaging Specialist 

National Anthropological Archives 
National Museum of Natural History 

Smithsonian Institution 
naultj@si.edu 

 



 
 
 
 
 
 

What is Breath of Life 
 



 
Goals of the Project 

•  Provide access to 
digitized materials for 
participants for their 
language revitalization 
efforts  

•  Create high-resolution 
digital surrogates for 
preservation of our 
collection  

                     NAA MS 1827, “Massachusetts or Natick vocabulary” 



Collaborators 

•  Digital Lab Staff 
–  Digital Program 

Manager 
–  Digital Imaging 

Technician 
–  Digital Imaging Intern 

•  NAA Staff 
–  Reference Staff and 

Interns 
–  Conservator 

•  Curator 
•  Program Staff 
•  Participants 



•  16 language teams 

•  17 manuscripts, 20 text selections 
from the John P. Harrington 
collection, and 7 previously 
digitized manuscripts   
•  1000 pages of archival 
manuscript material requested; 
over 3000 digitized in total 

• Material ranges from manuscript 
pages, bound notebooks of 
various sizes and binding styles, to 
notecards and slipfiles  

NAA MS 2797, “Menominee linguistic notes and texts 
 collected by Truman Michelson, 1910 “  

Breath of Life 2013 – By the Numbers 



 
Selection Process 



NAA MS 1549, “Wandot/Wyandot/ vocabulary January 8, February 7, March 15, 1881” 

 
 

Breath of life 2013 – variations on a 
theme 



 
The Harrington Issue 

•  Extremely large, not fully 
processed collection 

•  In the middle of another 
digitization project of the 
collection 

•  Approach differently than 
other materials 
–  Not digitizing full 

folders or boxes for 
preservation purposes 
(access only) 

John P. Harrington collection Box 483, Folder 1  



 
Prioritization  

Review 
Materials 

Meet with 
Conservator 

Send necessary 
materials to 

conservation 

Sort remaining 
materials 

Prioritize 
materials 

Begin 
digitization 

 NAA MS 3718, “Fourth of July, 1890 “ 



 
Materials: What we’re working with 

NAA MS 1442 NAA MS 954 



Above image from: NAA MS 1301 (T) and NAA MS 1041 (B) 

 



A textbook approach 

Hzen, Dan, Horrell, Jeffery, and Merrill-Oldham. (1998) “Selection for Digitizing: A Decision-Making Matrix,” Selecting Research 
Collections for Digitization – Full Report. 



Image Creation: 
Recommendations and Realities 



Questions to Consider   

•  What is being digitized? 
•  Where are these files going? 
•  Where will they be stored?  
•  Who will create them? 
•  What guidelines are being followed? 

Or created? 
•  What are the technical specifications? 





(Even more!) things to consider  

•  Staff and Time  
–  Expertise and Testing  

•  Imaging environment 
–  Space 
–  Lights 
–  Monitor 
 

•  Hardware and 
Software 
–  Scanner v. Camera 
–  Platform (Mac v. PC) 
–  Imaging Software 

•  Proprietary with 
equipment 

•  Adobe products 
•  Image Science 

Associates 
 

 
BOTTOM LINE: $$$$$$$$$$$$$$$$$$$ 



Scanner v. Camera 



 
Technical Specifications  

•  Bit depth 
•  Tone/Endpoints 

•  Color mode/profile 
•  Resolution 
•  File formats 



 
Technical Specifications – Bit Depth

  
•   Bit depth: the color information stored 

in an image; the higher the bit depth, 
the more colors an image can store. A 
1 bit image only shows two colors – 
black and white 
– 8 bit: 2^8= 256 colors  
– 16 bit: 2^16 = 65,536 colors 
– 24 bit: 2^24 = 16,000,000+ colors 
– 48 bit: 2^48 = 3,000,000,000 colors  



 
Bit Depth – Recommendations   

•  Capture images in a 
high bit depth (16 bit 
or higher) then 
convert to a lower bit 
depth as needed  

•  Higher bit depth 
images will increase 
accuracy of 
representing the 
original BUT will 
create larger files 



 
Technical Specifications – Tone   

•  Each pixel in an 
image file is assigned 
a value between 0 
and 255, with 0 being 
a “true” blackest 
black, and 255 being 
a “true” whitest 
white.  

•  Values below 9 (too 
black) or above 247 
(too white) lose all 
detail 



Tone - Recommendations 



 
Technical Specifications – Color Mode 
•  “Grayscale image files consist of a single channel, 

commonly either 8-bits (256 levels) or 16-bits (65,536 
levels) per pixel with the tonal values ranging from black 
to white. Color images consist of three or more grayscale 
channels that represent color and brightness 
information. Common color modes include RGB (red, 
green, blue), CMYK (cyan, magenta, yellow, black), and 
LAB (lightness, red-green, blue-yellow). The channels in 
color files may be either 8- bits (256 levels) or 16-bits 
(65,536 levels). Display and output devices 
mathematically combine the numeric values from the 
multiple channels to form full color pixels, ranging from 
black to white and to full colors.” 



Color Mode – Recommendations  

 
•  Adobe RGB 1998 (or 

Adobe sRGB, 
alternatively) is the 
recommended 
color profile for 
master files 



 
Technical Specifications – Resolution 

•  Resolution: the number of pixels in each 
dimension that can be displayed 

•  DPI: dots per inch (more appropriate for 
printing) 

•  PPI: pixels per inch (more accurately 
describes images) 

•  “Resolution Threshold”: the point where 
no matter how many more pixels added 
per inch, no more information from 
original is gained 



Resolution – Recommendations  

“All digital images created from reflective analog textual materials should have a 
minimum of 4,000 pixels along their longest dimension, and a minimum resolution of 400 
dpi. Text on the reverse side of an object may be scanned at 200 dpi. All reflective 
photographic materials are at a minimum of 5,000  
pixels on their longest dimension. 
 
All digital images created from transmissive analog materials should have a minimum of 
6,000 pixels along their longest dimension, and a minimum of 600 dpi.  
 
For example, an 8 x 10-inch photograph should be scanned at 500 dpi; a 5-inch 
photograph at 1000 dpi, etc. However, photographic items should never be scanned at 
less than 500 dpi — even if the longest dimension of the object is greater than 10 inches. 
When measuring the longest dimension of an image, round down to the nearest half 
inch. When calculating resolution, round up to the closest multiple of 25.  
Calculations should reflect the dimensions of actual item to be scanned, not its matting 
or support.” 



Resolution – Recommendations  



Technical Specifications – File Formats 



File Format - Recommendations 



Basic Scanning Workflow  
1.  Setup Scanning Workstation 
2.  Select Scanner Settings 
3.  Setup Scanner for Use 
4.  Scan 
5.  Save 
Extra: Batch Scanning  



1. Setup Scanning Workstation 
•  Turn on computer 

and scanner  
•  Remove any loose 

articles of clothing 
or jewelry  

•  Wash hands or wear 
gloves (no lotions, 
no hand sanitizers) 

 

•  You will need: 
–  A ruler 
–  Staging area for 

original objects 
–  Gloves and/or clean 

hands  
–  Neutral background 

board 



2. Select Scanner Settings 

•  Transmissive 
(negatives) v. 
Reflective 
(photographs, text) 

•  Resolution  
•  Color Profile  
•  Tonal Range  
•  Turn off adjustments! 



3. Setting up Scanner for Use 
•  Wipe down scanner glass with lint free cloth 
•  Place color bar target in appropriate place (center top, for 

instance) 
–  Utilizing a target is crucial for maintaining image quality and to serve 

as reference point if the integrity of images is every questioned  



3. Setting up Scanner for Use 
Measure the object you wish to scan. All digital images created from 
reflective analog textual materials should have a minimum of 4,000 
pixels along their longest dimension, When measuring the longest 
dimension of an image, round down to the nearest half-inch. When 
calculating resolution, round up to the closest multiple of 25. 
Calculations should reflect the dimensions of actual item to be scanned, 
not its matting or support.  



4. Scan 
•  Once you have determined the correct resolution, place the 

object on the glass, (for photographic material, face down) 
about an inch below, in the center of, the color bar. Place the 
background board over the scanner glass and carefully close 
the scanner lid.  



4. Scan 
•  Check your endpoints 

(white and black) to make 
sure you are within the 
correct range.  

•  If your endpoints are within 
the range, select the area 
to scan – you do not need 
to scan the entire scanner 
bed, just the object and the 
color bar target. Create a 
box with the dotted line 
around the color bar target 
and the object, with about 
¼ inch border of grey 
background around the 
edge.  



5. Save 

•  Assign appropriate 
filename and save 
images into the 
appropriate folder 
location 



Extra – Batch Scanning 
•  If multiple objects need to 

be scanned, and more than 
one fit on the scanner at the 
same time, they can usually 
be batched scanned.  

•  When determining 
resolution, set your 
resolution to align with the 
SMALLEST OBJECT ON THE 
GLASS, so that all objects 
reach the required pixel 
dimensions. 

•   Arrange the objects on the 
glass far enough apart so 
you will be able to get a ¼ 
inch border around each.  



Extra – Batch Scanning 

•  In the preview 
window, crop ALL 
images so there is a 
dotted border 
around each. 

•  When batch 
scanning, you do 
not need to include 
the color bar target 
in the scans.   



Bonus: Abridged Camera Workflow 
Turn on Nikon camera (slide control on the camera ).  



Bonus: Abridged Camera Workflow  
Turn on both Profoto lighting fixtures (black switches on the 
base near power cord)  
 



Bonus: Abridged Camera Workflow   
Launch Capture One software 



Bonus: Abridged Camera Workflow 
Setup camera counter and filenaming in Capture One 



Bonus: Abridged Camera Workflow   
Rotate the ‘Focus Ring’ on the Nikon’s lens to focus. Note 
that the image will be very pixelated even when it is focused. 
Once image is focused, hit command+K or Capture key 
 



Bonus: Abridged Camera Workflow  
Using the Grayscale on the Device/Object Target, make sure 
your whites are between 242 and 248 or whatever is 
appropriate for you subject matter.  



Create Lens Cast Calibration 
 
 
 
 
Set Base Characteristics 
 
 
 
 
Assign Capture Adjustments 
 
 
 
 
 
Set White Balance 



Bonus: Abridged Camera 
Workflow 
Settings in Details Tab  
 



Bonus: Abridged Camera Workflow 
Place a series of RGB read outs by clicking various RGB 
patches on the Device Level and/or Object Level Targets 
 



Image Creation – Conclusions   
•  Considerations: 

–  Time 
–  Staff 
–  Hardware and 

Software 
–  Imaging Environment 
–  Bit depth 
–  Tone 
–  Color Mode  
–  Resolution 
–  File Formats 

Don’t forget to use a target!  



 
More is More: The Role and 
Responsibility of Metadata 



What is metadata?   
•  Literally “data 

about data” 
•  Descriptive 

information about 
collections 

•  value-added 
information used to 
arrange, describe, 
track, and enhance 
access to 
collections  

•  Metadata is more 
common in daily 
online life than you 
might think: 
–  Photo tagging 

(Facebook, 
Instagram) 

–  #Hashtags (Twitter, 
Instagram, 
Facebook) 

–  Blog tags 
 



 
 
 

What are the different types of metadata?  
(Source: Source: Baca, Murtha, editor. Gill, Tony, Gilliand, Anne J., Whalen, Maureen, and Woodley, Mary S. (2008). “Setting the Stage,” Introduction to Metadata 

Online Edition, Version 3.0, http://www.getty.edu/research/publications/electronic_publications/intrometadata/index.html 
 
  
 

Type Definition Example 

Administrative Metadata used in managing and 
administering collections and 
information resources 

- Acquisition information 
- Rights and Reproduction tracking 
- Documentation of legal access requirements 
- Location information 
- Selection criteria for digitization 

Descriptive Metadata used to identify and 
describe collections and related 
information resources 

- Cataloging Records 
- Finding Aids 
- Differentiations between versions 
- Specialized indexes 
- Curatorial information 
- Hyperlinked relationships between resources 
- Annotations by creators and users 
 

Preservation Metadata related to the preservation 
management of collections and 
information resources 

- Documentation of physical condition of resources 
- Documentation of actions taken to preserve 
physical and digital versions of resources 
- Documentation of any changes occurring during 
digitization or preservation 

Technical Metadata related to how a system 
functions or metadata behaves 

- Hardware and software documentation  
- Technical digitization information  
- Tracking of system response times 
- Authentication and security data 

Use Metadata related to the level and 
type of use of collections and 
information resources 

- Circulation records 
- Physical and digital exhibition records 
- Use and user tracking 
- Content reuse and multiversioning information 
- Search logs 
- Rights metadata 



 
Where is metadata?  

•  Different levels of 
metadata exist in 
different places 
–  Embedded into files 
–  Filing cabinets! 

•  Accession Records 
•  Catalog Cards 

–  Collections 
Information Systems 
and Databases 
•  Online, public-facing 

platform  
•  Internal collections 

database system 



When is metadata?   
•  Collections staff has 

been working with 
metadata since the 
beginning – term not 
commonly utilized until 
collections started 
being digitized 

•  Metadata should be 
collected and applied 
to files as soon as 
possible – lag time 
between image 
creation and metadata 
enhancement could 
result in inconsistencies 
and missing information 

•  Build metadata into 
digitization workflow 



Who is metadata?  
•  Standards bodies 

–  JEITA 
–  IPTC 
–  PLUS 

•  Photographer trade 
associations 
–  SAA 
–  ASMP 
–  APA 
–  EP 
–  NPPA 

•  Cultural Heritage and 
Government Institutions  
–  AAT (Getty) 
–  LOC 
–  FADGI 
 

•  When working with metadata, 
some “who’s” to think about: 
–  Who is supplying the metadata? 

•  Curators  
•  Donors 
•  Collections staff (archivists, 

librarians) 
•  Photographers/Imaging 

Technicians 
–  Who is applying the metadata at 

its various levels? 
•  Catalog records 
•  Database entries 
•  Embedded files 

–  Who is using the metadata? 
•  Staff 
•  Researchers  
•  Exhibitions  
•  Publications  



Why metadata? 
•  Accessibility 
•  Discoverability  
•  Collections 

Management 
•  Usability 
•  Rights and 

Restrictions 
•  Standard 

Policies and 
Procedures  

 



How metadata? 
•  IPTC: International Press Telecommunications 

Council 
•  Dublin Core 
•  Descriptive and Technical  
•  Embedded 
 



How metadata?   
Basic Guidelines for Minimal Descriptive Embedded 
Metadata in Digital Images 
by EMDaWG (Embedded Metadata Working Group – 
Smithsonian Institution) 
April 2010 



How metadata? Requirements 

•  Basic	
  Guidelines	
  for	
  Minimal	
  Descrip4ve	
  
Embedded	
  Metadata	
  in	
  Digital	
  Images	
  
by	
  EMDaWG	
  (Embedded	
  Metadata	
  Working	
  
Group	
  –	
  Smithsonian	
  Ins4tu4on)	
  
April	
  2010 



How Metadata? Suggested 



Locating metadata content 



 
Creating a metadata template 

•  Open a file from the folder you’re working on, and 
go to File!File Info in Photoshop. Using the 
EMDAWG guidelines, the following fields are 
populated: 

•  Document Title: The number of the manuscript 
(from the Local Number field in SIRIS).  

•  Author: National Anthropological Archives 
(EMDAWG – Creator) 

•  Description: The title of the manuscript, also from 
the SIRIS record. 

•  Keywords: The creator of the manuscript; a co-
creator (if one exists); MS and its number; the 
culture the manuscript pertains to; and the subject-
topical phrases. These all come from the SIRIS 
record 

•  Copyright Status: UNKNOWN. It is extremely 
important that the copyright status says UNKNOWN.  

•  Copyright Notice: “The Smithsonian continues to 
research information on its collections. Contact 
Smithsonian for current status.” This is the same for 
all material.  

•  In the IPTC tab, make sure the Source field is 
populated. It should say, “NAA-Natl. 
Anthropological Archives, Smithsonian Institution.”  



Exporting Metadata 
•  Once you have created the 

metadata template, you will want 
to Save (or Export) it for later use. 

•   In the metadata window, click 
Export. A new Save window will 
pop up, and it will automatically fill 
in the filename of the file currently 
open.  

•  You may leave it as such, or make it 
shorter and simpler, like just using 
the number of the manuscript for 
which the metadata applies.  

•  Click save. You have created a 
metadata template that can be 
used on a collection of images as 
needed. 



Embedding Metadata 
Metadata can be embedded more quickly embedded using Adobe Bridge  
Open the files in Adobe Bridge. The files may take several minutes to load and go through 
the preview extraction.  
Once all the files have loaded, select all files (command + A) then go to Tools ! ”Replace 
Metadata”  
 
 



Embedding Metadata 
•  Select the corresponding metadata 

template. Embedding will begin 
automatically and may take a few 
moments to complete. Once completed, 
bridge will automatically save the 
metadata. 

•  On the lower right hand side, confirm that 
the metadata has been embedded. 

•  Confirm that metadata has been 
embedded by opening the files in Adobe 
Photoshop and checking the “File Info.”                                                                                                                                                 



 
Metadata - Conclusions 

•  Metadata is already 
an integral part of 
Collections 
Management 

•  Embedding and 
Utilizing Metadata will 
increase accessibility, 
usability, 
discoverability, 
organization, 
alleviate rights and 
restrictions issues 



Quality Control and Post-
Processing 

How much is too much? How 
much is enough? 



 
What is Quality Control?    

•  Series of processes done after 
digitization to ensure you are meeting 
your predetermined standards and 
benchmarks, while maintaining 
accuracy, quality, and consistency. 



 
Quality Control Checklist  

Kenney, Anne R. and Oya Y. Reiger. “Establishing a Quality Control Program,” Chapter 4, pp.61-73. (2000). 
Moving Theory into Practice: Digital Imaging for Libraries and Archives. Mountain View, CA: Research 

Libraries Group. 
 

Prerequisites for QC 

• Identify products and 
goals 

• Agree on Standards 
• Determine a Reference 

Point 
• Understand the 

Limitations of Current 
Knowledge, Practice and 
Technology  

Setting up your QC 
Program 

• Identify Scope 
• Determine Methods 
• Evaluate System 

Performance 
• Codify Inspection 

Procedures 
• Control QC Environment 

• Hardware configuration 
• Image-display software 
• Monitor setup  
• Color quality control  
• Color management 
• Viewing conditions 
• Human characteristics  

Assessing Image Quality  

• Evaluate: 
• Resolution  
• Color and Tone 
• Overall appearance 



 
Photoshop - Actions 

•  Post-processing needs 
like conversion (16-bit 
to 8-bit), rotation, 
embedding metadata, 
curve adjustments can 
be performed in batch 
actions in Photoshop.  

Open Photoshop. Go to the Action tab 
on the right side and click the 
dropdown arrow.  Click “New Action.”  

 



Creating an Action 

Naming the Action 
•  A new naming window will pop up. Create a 

simple, explanatory name for the action, such 
as “8 bit and CCW rotate.” 

•  Click “record.” Photoshop will record all of the 
steps you complete and save them as a single 
action that can be applied to an entire folder 
of images for faster, more efficient processing. 

Running the Action   
•  Go to File ! Open and open the 

first image in the folder you are 
processing.  

•  Go to Image!Mode!8 Bits/
Channel  

•  Once you have 
converted the 
image to 8 Bits/
Channel, you 
may notice that 
Photoshop will 
reflect that in 
the tab where 
the filename of 
the image is 
(RGB/8* 
indicates this):  

 



Completing an Action 

Saving the Changes   
•  Go to File ! Save. Once the dropdown 

menu has disappeared, go to File ! 
Close. If you get the following popup 
window, just click Ok.  

Stopping the Action 
•  After you have completed all the steps 

for the action, you will have to stop 
recording the action. Click the “stop 
button,” the small square at the bottom 
of the Action menu.  



Running an Action 

Playing the Action 
•  Now that you have created the Action, 

you can “play” it so the steps are 
applied to the entire folder of images. 
Go to File ! Automate! Batch 

Setting the Action 
•  A new window called “Batch” will pop 

up. In the “Play” section select the 
action you have just created. In the 
“Source” section click on Choose; 
locate the folder containing the files you 
want to run the batch action on; select 
it. In the Destination section (where the 
files will end up), do the same as the 
step before. The window should look like 
this:  



Completing an Action 
•  Click “Ok.” The batching will automatically begin and run through 

the files contained within the folder, which will take anywhere from a 
few seconds to a few minutes, depending on the amount and size of 
the files.  

 



De-skew images as needed 



Cropping Images  



Cropping Images 

•  Once you have 
cropped the first image, 
go to Image!Image 
Size and note the pixel 
dimensions. You will 
want to make a note of 
them so you can set the 
crop area to these 
proportions so all the 
images in a given 
collection will be the 
same size.  



Cropping Images  

Instead of cropping it “freehand” you will set the crop 
area based on the pixel information from the previous 
image.  

When you go to crop the image, you will notice that the crop area is 
constrained to the proportions you’ve set. Move the crop area around so 
it fits snugly around the image, while still leaving some background. Once 
you have cropped it to the correct size, hit enter. The image will be 
cropped. Click File!Save and File!Close. 
 



 
Inspection of 10% of images at 100% 

magnification 
 



Advanced Quality Control 
DICE  (Digital Image Conformance Evaluation) 



Advanced Quality Control   
DICE (Digital Image Conformance Evaluation) 



 
Advanced Quality Control: GoldenTouch Auto-Cropping 

Software 
  



Advanced Quality Control: GoldenTouch 
Auto-Cropping Software 

  



Advanced Quality Control: GoldenTouch 
Auto-Cropping Software 

 



 
Quality Control Checklist  

Kenney, Anne R. and Oya Y. Reiger. “Establishing a Quality Control Program,” Chapter 4, pp.61-73. (2000). 
Moving  Theory into Practice: Digital Imaging for Libraries and Archives. Mountain View, CA: Research 

Libraries Group. 
 

Prerequisites for QC 

• Identify products and 
goals 

• Agree on Standards 
• Determine a Reference 

Point 
• Understand the 

Limitations of Current 
Knowledge, Practice and 
Technology  

Setting up your QC 
Program 

• Identify Scope 
• Determine Methods 
• Evaluate System 

Performance 
• Codify Inspection 

Procedures 
• Control QC Environment 

• Hardware configuration 
• Image-display software 
• Monitor setup  
• Color quality control  
• Color management 
• Viewing conditions 
• Human characteristics  

Assessing Image Quality  

• Evaluate: 
• Resolution  
• Color and Tone 
• Overall appearance 



DigitalAssetManagement, Storage!  



Strength of Storage 

•  What are your 
storage needs? 
–  Throughput 

•  What are your 
storage capabilities? 
–  Staff  
–  Budget 

•  What is the level of IT 
support? 
–  Infrastructure 



STORAGE WARNING   

 
•  DIGITAL FILES NEED TO BE BACKED UP IN 

MULTIPLE LOCATIONS  
•  DIGITAL FILES NEED TO BE MIGRATED  
•  DIGITAL FILES NEED SPACE TO LIVE 



Storage Options  

Good,  Better 
•  Cloud-based Storage 
•  Network Attached 

Storage (NAS) 
•  Locally managed 

servers 
•  Local external storage 

–  RAID Hard Drives 
 
 

Best 
•  Trusted Digital 

Repositories  
•  Digital Asset 

Management Systems  
–  Desktop 
–  Workgroup  
–  Enterprise 



Local Storage  
Requires constant maintenance and upgrading 
Hard drives fail!! 
Migration and offsite backup 



Cloud Storage  

•  Institutional  
–  DuraCloud 
–  Chronopolis 
–  Digital Preservation 

Network 

•  Commercial  
–  Amazon 
–  Mozy 
–  Google Drive 
–  iCloud 
 



DSpace 

•  Free, open-source 
software to build 
open digital 
repositories 



Trusted Digital Repositories 
•  “A trusted digital repository is one whose mission is to 

provide reliable, long-term access to managed digital 
resources to its designated community, now and in the 
future.” (Trusted Digital Repositories: Attributes and Responsibilities 
An RLG-OCLC Report) 

•  Digital Preservation Coalition 
•  HathiTrust (libraries) 



DAM useful  
•  “Instituting digital asset management (DAM) in cultural 

heritage institutions tends to be a major IT initiative. What 
is often overlooked is that DAM in isolation merely 
provides a resource intensive organizational tool for 
digital assets within the institution. The more important 
aspects of a DAM implementation are the workflow 
processes and procedures that are integrated into the 
application, the links the application makes internally 
and externally to other institutional systems, and 
ultimately how the implementation changes and 
enhances the institution’s business processes  
surrounding the use of digital assets.” 
–  Howard Goldstein (Center for Digital Imaging, Inc.) and Rob Hendriks (The 

Rijksmuseum, Amsterdam) 



DAMS workflow - 1 



DAMS workflow - 2 
•  NEGATIVES: 
•   XX_neg folder-> MASTER 
•   XX_post folder-> SUBFILES 
•   XX_crop folder-> SUB-SUBFILES 
•   XX_jpg folder-> do not ingest 
•  FILES WITH CROPS AND VERSOS 
•   XX.tif file -> MASTER 
•   XX_crops folder and/ or Versos -> SUBFILES 
•   XX Verso Crops (if they have been 

renamed) -> SUB-SUBFILES 
•  FILES WITH CROPS AND VERSOS [Alternative, 

usually Photo Lots] 
•   XX.tif file (recto) -> MASTER 
•   XX.tif file (verso) -> MASTER   
•   XX crop (recto) -> SUBFILE 
•   XX crop (verso) -> SUBFILE 
•  FILES WITH CROPS AND NO VERSOS 
•   XX.tif file -> MASTER 
•   XX_crops folder -> SUBFILES 
•  FILES WITH VERSOS AND NO CROPS 
•   XX.tif file -> MASTER 
•   XX Verso Crops -> SUBFILES 



DAMS workflow - 3 

•  Confirm ingest 
•  Track ingest 



DAMS workflow - 4 

•  Search and verify assets  



DAMS workflow - 5 

•  Apply DAMS level metadata 

• Apply DAMS security policies  



DAMS workflow – 6   

•  Create a Folder with Collection Name 
and Number  



Storage Conclusions   

•  Data needs to be backed up in 
multiple locations, migrated, and takes 
up space 

•  Decide which storage and/or digital 
asset management system is right for 
you 
–  infrastructure, support, staff, time, money 

and NEEDS 



All About Access 



Allowing Access 

Why? 
•  Mission driven 
•  Reach newer, bigger 

audiences 
•  Expectation of public 
•  Feasibility  
•  Relevance 
•  Goodwill relationship with 

source communities 
•  Reduce handling, 

increase access to fragile 
collections 

How? 
•  Who are your users? 
•  How will they access 

collections? 
•  How will you provide 

access? 
•  Open access, freely 

available? Or fee for 
service? 

•  Rights and Restrictions 
•  Copyright issues 
•  Staff, budget, time 



Open Access 
The Getty Open Content Program 

Digita Vaticana 



Increasing Access   

John P. Harrington web portal  
•  Digital access to various collections 
– Manuscript and Microfilm  
– Photographs 
– Sound Recordings 
– Botanical specimens 
 



 
Increasing Access – Harrington web 

portal 



Increasing Access – transcription.si.edu 



Increasing Access – Arcadia project 

•  Freely available, downloadable PDFs of 20,000 pages of endangered 
language manuscript material and 15,000 pages of associated text 
related to sound recordings 

•  Online mp3’s of 3500 sound recordings  



How to create access – derivatives  

Go to File > Automate > 
Fit Image 
 



How to create access - derivatives 
A window will pop up – enter the 
follow dimensions into the 
appropriate boxes – click OK 

Go to Image > Image Size. An 
Image Size window will pop up.  

In the resolution field, enter 72. Make 
sure pixels/inch is selected. Make 
sure box for “Resample Image” is 
unchecked. Click ok. 



How to create access - derivatives 

Go to Filter > Sharpen > 
Unsharp Mask 

In the Unsharp Mask 
window enter the above in 
each field. Click Ok. 



How to create access - derivatives 

Go to File > Save As. In the Save As 
window, make sure the format is 
“jpg,” and the box for “Embed 
Color Profile” is checked. Click 
Save.  

In the JPEG options window, make 
sure the options are: 
Quality: 8 
Baseline: Standard 
Click Ok. Close window.  



How to create access - derivatives 
You may want to create a Word 
file of the designated PDF Cover 
Sheets. There are both generic 
cover sheets and project or 
material specific cover sheets. 



How to create access - derivatives 
Combining Files and Cover Sheet into 
PDF file. 
Open Adobe Acrobat Professional.  

A Start Menu may pop up. You may 
choose “Combine Files into PDF” 

Or you may choose File!Create 
PDF/or Combine!Merge/
Combine Files into a Single PDF  
 



How to create access - derivatives 

In the Combine Files window that opens select “Add Files” or drag files 
and PDF cover sheets into the window. Make sure Single PDF is checked 
and make sure the file size icon is on the middle setting.  Add the 
individual images to be combined, or a whole folder containing them all.  



How to create access - derivatives 

Click Combine Files. Depending on the number of images, it may 
take a few or several minutes to finish; you can watch the progress at 
the bottom of the window. Once the PDF is created, it will appear in 
a new window, starting with the cover sheet. From here, go to 
File!Save.  



How to create access – derivatives  
Once the file has been 
saved, go to 
File!Properties. A 
“Document Properties” 
window will pop up 

Click “Additional 
Metadata” 

(If the metadata template has been 
previously saved/exported, it will be 
available in Acrobat.)  

 



How to create access - derivatives 

A File Info window will pop up (it will look similar to the one in 
Photoshop). Click the arrow to the right of “Description.” A list of 
metadata templates will appear. Choose the appropriate 
template. The fields will populate. Click Ok. Save PDF before 
closing. 
 



THANK YOU! 
 

ANY QUESTIONS?!   

naultj@si.edu 
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